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Large Format Printer (8x10 and 11x14) Instructions 
Targets can be reduced to narrower widths if necessary – see Appendix A. 
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If you downloaded one of our printer-specific profiling kits, please refer to the appropriate Appendix for 
further details. 
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Introduction and Setup 
Thank you for selecting our custom profiling service. We endeavor to provide the most accurate printer 
profiles possible. These instructions are comprehensive because the better your printer is set up, the better 
the profiles will work for you. We want to extract every possible bit of performance from your printer; this 
document is an aid towards that end. If you have questions at any stage of the process, please contact us. 

Please fill out the Profile Order Form and submit it with your targets and payment. This document is a 
guide to optimizing and evaluating your printer, printing our profiling target, and using profiles. We 
typically measure your targets and make the profiles within two business days of when we receive the 
target prints. If you have any questions, please do not hesitate to contact us. Contact information is included 
on the final page. 

At the risk of turning away business, first make sure that custom printer profiles are what you need. If your 
computer does not have a calibrated monitor, please do not invest in printer profiles yet! You need to be 
able to trust what your monitor shows before worrying about how the results look in print. You can 
calibrate your monitor visually, or for far better results, use a dedicated hardware calibrator. Our web site 
contains calibration tips and reviews of several popular calibration systems. Printer profiles are also tuned 
to a calibrated viewing system – usually a D50 light booth – although we can optimize the profiles for other 
viewing conditions as well. 

Our profiles are intended for color printing. They give very good results for B&W work, however obtaining 
perfectly neutral black and white output from a color printer while possible, can require extensive print 
iterations. Our profiles will get you close to perfect. If, however, the majority of your work is true B&W 
prints, we suggest purchasing a dedicated monochrome printer. 
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Profile Target Descriptions 
Our profiling kit contains several targets. The first is a small 3x5" target (DCP-PrintEval.tif) designed to 
help optimize your printer setup. The other, larger targets are the ones we measure to make your profiles. 
You need to send us print(s) from the large target. Sending the small printer setup target is optional, but 
helps us identify any potential issues with your printer setup. 

Our profile targets are saved as TIFF format images. There are two versions, summarized in the table 
below. (Note: Printer-specific target downloads only contain one file size). You only need to print one 
version – the two sizes are provided to allow printing the most convenient format for you. 

Both target versions contain approximately 1100 color patches. The 8x10 targets require printing three 
pages, while the 11x14 target fits on a single page. The targets were developed from our analysis of profile 
target prints from thousands of RGB printers and papers. Two thirds of the target are devoted to overall 
color rendition, while the remaining third is used for gray scale optimization and improved highlight and 
shadow rendering. The overall balance of the target is carefully maintained to avoid profile color space 
distortions. This target contains more data than is used by most profiling companies, requiring more work 
on our end, but we believe you will notice the difference in the profiles. 

Both versions of the targets contain identical color information, so print the size that is most convenient for 
you. The 8x10 target can be printed on larger (e.g. 8.5x11 or A4) paper sheets as long as the target images 
are not  resized. You do not need to trim the target down unless it makes it easier for mailing. We will trim 
as needed. 

Target Size 
(inches) 

Number 
of pages Target Filename(s) 

11x14 1 DCP-11x14.tif 
8x10 3 DCP-8x10-p[1-3].tif

Printer profiling targets – pick the most convenient format. 
Only print one size per paper type. 

If your printer does not print up to 8 inches wide, the targets can be cropped in width. This must be done 
carefully to avoid corrupting the color data and scan features. Detailed target sizing instructions are given 
in Appendix A. 

Additional printer specific targets are available from our web site. These targets have been specially 
formatted for the individual printers. We have targets available for all Fuji Frontier, Agfa d-Lab, and both 
Noritsu Laser (model 3xxx) and MLVA (model 2xxx) digital printers. Instructions on the use of these 
targets appears in Appendix B and C. 

The file resolution for the targets (except Noritsu and Agfa models) is 300 ppi. If you absolutely must 
change the resolution of the profiling target file to support your printer, you can do so, although you should 
avoid this if possible. In the Photoshop Image Size dialog box, select the "Nearest Neighbor" resampling 
method. Do not use either bilinear or bicubic sampling! This will corrupt the colors in the image file. 
Again, please contact us if you have any questions. Complete instructions are provided in Appendix A. 

The main color fields of each target are arranged in a carefully calculated, semi-random order. This is done 
to detect and compensate for angular print variances in optical printers and thermal cycle time limitations 
of dye-sublimation printers. A miniature version of the entire target with the colors sorted ordered in a 
more easily readable manner is printed in the margins of the first page of each target set. This gives a quick 
visual evaluation of your printer's performance. 
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Printer Optimization 
For the best results, check your printer’s performance using the printer evaluation target. This will ensure 
your printer is producing optimal output before printing the profiling target. The better your printer is set 
up, the better the profiles will be. 

Before you begin the profiling process, make sure your printer is behaving properly: 

• If the printer has a calibration routine, run it for the paper stock you are profiling. 

• For inkjets, run a nozzle check, and ensure that all nozzles are clean and aligned before proceeding. 

• Dye-sub printers should run an alignment check, and a densitometric or gray-balance calibration if 
available. The printer should be turned on for at least half an hour before printing the targets. 

• Commercial printers (LightJet/Gretag, Durst, Chromira, Agfa, Noritsu, Fuji Frontier, etc.) should 
perform a full calibration cycle and run several test prints to ensure the machine is warmed up and stable. 

 

Printer Evaluation Target 
The next step is to print our 3x5" printer evaluation target (DCP-PrintEval.tif). This process is most useful 
for inkjet users needing to determine which media setting matches best with a third party paper. We highly 
recommend inkjet users print at least one copy. 

For non-inkjet printers, or if you already know the appropriate media settings, this step is optional. 
This target contains several features to aid you in evaluating your printer’s performance. The size is small 
to allow it to be used with all format printers and so the target can be stored in a typical snapshot sleeve. 
For evaluation purposes, this target should not be re-scaled unless absolutely necessary. Like our profiling 
targets, the resolution is set to 300 ppi. If you need to change the resolution, use the nearest neighbor 
interpolation method in Photoshop. 
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First, select the paper type in your print driver that most closely matches the paper you are printing on. This 
is critical for inkjet users, as the paper type determines ink limits and mixing of the black inks. Appendix E 
has pointers on finding the best media setting to use with third party media. Next, turn off any automatic 
color adjustments. This is required for accurate profiles, as automatic adjustments perform corrections 
based on image content. Unless you only want to print profiling targets, these corrections negate the 
profiles. 

Select the highest quality printing mode. Inkjet users should decide what output resolution (e.g. 1440 or 
2880 dpi) they will use most. There are very slight color differences between the modes, so the profile will 
work well for any mode, but will be optimized for the mode you select. 

Inkjet users should typically select a manual color mode (Canon: Manual Color Adjustment, Epson: No 
Color Adjustment, HP: No Automatic Image Enhancement). On your initial print, look at the crosshairs in 
the Ink Density Check box. This is particularly important for inkjet printers. Ideally, all the crosshairs 
should be visible. Significant filling in of the crosshairs indicates too much ink is being dumped on the 
paper. If your printer driver allows adjusting the ink volume (sometimes labeled intensity), try reducing it 
slightly. If you are using a non-OEM paper stock, try changing the paper type in the driver setting. This 
will change the ink deposition volume as well. On inkjet printers, some ink filling is expected on the finest 
crosshairs. No ink fill indicates you could benefit from slightly higher ink density. 

If you are using third party papers with an inkjet printer, particularly Epson models, check the grayscale 
gradient. The lower steps may all be black. If so, try another media setting. There often is no option that 
gives separation between steps 1 and 2. Choose a media setting that provides the best shadow resolution. 

Next, look at the black area. Ink pooling, paper warping, or very slow drying also indicate too much ink. If 
you are using a third party paper, try changing the media type. If you use a RIP that allows control over ink 
limiting, careful adjustment here can improve shadow details immensely. 

Now, examine the rest of the target. Do not worry if the color primaries do not appear as they do on-screen. 
Without using spot colors, few printers are capable of reproducing fully saturated colors exactly. In general, 
the Cyan, Magenta, and Green color will darken significantly. If you see banding, print dropouts, or 
splotches, run a printer cleaning cycle. 

If the overall gray background is uneven, this indicates that either the printer or paper is of poor quality. If 
acceptable results are obtainable on a different paper, the paper stock is at fault. Profiles of low quality 
papers will not produce good results – save your money. 

The Color Gradient contains the full range of color your printer can produce. It is normal to see gaps in this 
gradient. These are colors that your printer can not recreate. The profile will help smooth out any 
discontinuities or banding, but will not invent new colors for your printer. 

To use the printer evaluation target to discover which inkjet media setting gives the best print quality, use 
the image placement options in either Photoshop or the printer driver to print the target in the upper left 
corner of a page. Switch to a different media setting, move the evaluation target print location to the upper 
right and print again. Multiple versions can be printed on a single page to help decide which media setting 
gives the best results. 
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Epson Specific Instructions 
 
If more than the first two steps of the Neutral gradient in our printer evaluation target are indistinguishably 
black, you probably will have poor shadow detail resolution. For Epson printers, this can occur with the 
“No Color Adjustment” mode. If so, you have a choice to make. For the widest color gamut, “No Color 
Adjustment” is necessary. For the most linear gray scales, select the “Color Controls” option. In general, 
prints made with “No Color Adjustment” have more range, but if the best shadow detail is more important 
than a wide color range, select “Color Controls” for the printing option. 
 
For all Epson printers: 
• Disable High Speed mode for best quality 
• Do not select Epson Natural Color (Macintosh) or Epson Vivid Color (Windows). 
• Disable Edge Smoothing (if available). 
 
 
Wide format Epson printers: Use No Color Adjustments for all printing; the ink output of these printers 
is more linear than with the desktop models. The image below highlights these settings. Remember to 
select the correct paper type! 
 

 
Epson Advanced Preferences 

Note: Choose the print quality you care about most. The profile will be optimized for this output dpi, but 
will still be very accurate for other resolutions as well. There is negligible color difference on Epson 
printers between 1440 and 2880 dpi output. Accurate 720 dpi printing, however, requires a different printer 
profile. 
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Epson 2200/2100 and more recent printers (Epson 4000, R800, etc): Use “No Color Adjustments” 
mode. The 2100/2200 driver is better controlled than previous Epson desktops. This is also true for other 
more recent models (printers released from 2003 and newer).  
 
If you use an older version of the printer driver, follow the graphic above to select No Color Adjustments 
mode. The newer Epson drivers require a more convoluted approach, and differ between Windows and 
Mac implementations. 

 
Epson Windows Driver Settings 

    
In the Printing Preferences dialog: 

1. Select "Best Photo Quality" if available 
(depends on paper type). 

2. Select Paper Type. 
3. Do not select PhotoEnhance. 
4. Press Advanced to open the Advanced 

Options dialog. 

 

 

 

 

 

In the Advanced Settings dialog:  
1. Select the resolution you most often use. 

Differences in color performance between 
1440 and 2880 are minimal, so this setting is 
not critical. Note: the 720 dpi setting has 
significantly different color output, so it 
needs a separate profile. 

2. Select ICM in the Color Management settings 
3. Select No Color Adjustment in the ICC 

Profile settings (enabled after selecting ICM). 
4. Do not select High Speed, Black Ink Only, or 

Edge Smoothing. 
5. Save the settings with a name that you can 

remember. You will need to use this same 
setting when printing with your profile. 
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Epson Macintosh Driver Settings 
    

In the Printing Preferences dialog:  
1. Select Paper Type. 
2. Select "Custom" mode. 
3. Press Advanced to open the Advanced 

Options dialog. 

 

 

 

 

In the Advanced Settings dialog:  
1. Select the resolution you most often use. 

Differences in color performance between 
1440 and 2880 are minimal, so this setting is 
not critical. Note: the 720 dpi setting has 
significantly different color output, so it 
needs a separate profile. 

2. Select No Color Adjustment in the Color 
Management settings. 

3. Do not select High Speed. 
4. Do not select Edge Smoothing. 
5. Save the settings with a name that you can 

remember. You will need to use this same 
setting when printing with your profile. 

 
 
Epson R800, R1800 and Gloss Optimizer: 
If you are going to use the gloss optimizer on a particular paper for your prints, enable it when printing the 
profiling targets as well. Several other profiling companies request the optimizer not be used because it 
throws off measurements on standard profiling equipment. We use a specialized setup for measuring these 
prints, and including the effects of the gloss optimizer coating gives you 
the best accuracy possible. You can reduce the usage of the gloss 
optimizer by selecting the “Auto” mode for printing the profile targets. 
This only sprays the coating over the image area rather than coating the 
entire page. 
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Epson 1270/80/90 printers: We strongly recommend using the “Color Controls” options for your profiles. 
The increased shadow resolution and linear output more than compensates for the reduction in color gamut. 
This is particularly true for matte finish papers. Access this option through the Advanced menu of your 
printer setup dialog. The figure below shows the Advanced menu choices. Select Color Controls, change 
gamma to 2.2 for best quality output, turn off high speed printing and change the brightness very slightly. If 
you leave brightness, contrast, and saturation all at zero, the printer driver may not use a consistent state. 
Increasing brightness by one point has no visible effect on image quality, but forces the Epson driver to 
store your changes. 
 

 
Epson Color Controls Settings 

Epson 1270/80/90 printers with third party inks: This is a difficult situation. Most third party inks, 
advertising claims aside, do not have as wide a color gamut (have less saturation range) than do the Epson 
OEM inks. A custom profile will not improve the ink saturation – that is a function of the ink itself. Using 
the Color Controls mode recommended above truncates this range even more, often resulting in flat, low 
contrast colors (particularly dark browns and greens). The No Color Adjustments mode makes 
posterization and banding more likely in shadow areas. This is particularly true of third party pigment inks. 
Pick the setting that looks the least bad and go from there. Sorry, but we simply have not seen many third 
party ink options for these printers capable of producing output quality that we are satisfied with. 

Save the settings with a sensible name. You will need to save individual settings for each paper type you 
plan to use. Use these settings to print the profile target, and when you print files using the profiles we 
create for you. 
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Canon Specific Instructions  
 
Setting up Canon printers is more straightforward, but varies between Windows and Macs. The step 
numbers below refer to the screen shots on the following page. The screen shots are for the Windows 
driver; the Mac version is similar with some naming variations. 
 
Windows: 
• Main settings tab: 

(1) Select the appropriate media type. If there is not an exact match, either select the closest paper type 
or follow the printer optimization instructions above. 

(2) Select "Custom" Print Quality. 
 Choose the print quality setting you wish to use. 
 Set the halftoning to Diffusion. 

(3) Select Manual Color Adjustment. 
 Set all sliders to 0. 
 Turn off ICM. 
 Set Print Type to "None". 
 Note: The above two settings are critical. Missing one or both is the cause of the majority 

of the problems we see with Canon profiling targets. If your driver does not offer the "None" 
setting for the print type, please download the latest driver from Canon. 

 Set Brightness to "Normal". 
• Effects Tab: 

o Turn all effects off. 
• Profiles tab (Note: These are printer settings, not Icc profiles): 

o Save your settings with a sensible name. This is what you will use when printing with the profile.  
 
 
Mac: 
• Print Dialog box: 

o Select the media type. If there is not an exact match, either select the closest paper type or follow 
the printer optimization instructions above. 

o Click the Details button. 
• Detailed Settings Dialog: 

o Select the print quality you want. 
o Select Diffusion halftoning. 
o Select the Special Effects button and disable all the effects. 
o Click the Color (or Manual for some drivers) button. 

 Set Color Correction to None. 
 Set all sliders to 0. 
 Disable "Color Balance" if this option exists. 

• Go back to the main Print Dialog box and click the Apply button to save your changes. Choose a sensible 
name, as this is the setting you will need to use when printing with the profile. 
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Canon Setup Screenshots 

 
Printing Preferences: [1] Select paper type. [2] Choose "Custom" print quality. [3] Select Manual Color Adjustment. 

 

 
[2]: Print Quality: Choose best detail/quality and diffusion halftoning (if supported by media type). 

 

 
[3]:Color Adjustment: All sliders at 0, Enable ICM not checked, and Print Type set to "None". 
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Effects tab: All effects OFF.
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HP Specific Instructions 
 
DesignJet 130: 

1. Select the appropriate paper type on the 
Paper/Quality tab of the Printing Preferences. 

2. Choose "Best" printing mode – unless you 
want less than the best... 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. On the Color tab, select the "Manual" color 
output mode. 

4. Choose "Managed by Application" as the color 
matching method. 

5. Save the settings with a sensible name – you 
will use the same settings when printing actual 
images with the profile. 

 
 
Older HP printers: Select the paper type and "Best" 
quality printing mode. Disable "Automatic Image 
Enhancement" on the Advanced tab: 
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Printing the Profile Targets 
At this point, you are ready to print the actual profiling targets. Save your printer settings! Every time you 
print using the profile you will need to use these same settings. Inkjet users, please run a nozzle check 
before printing the targets. Examine the printout carefully, using a loupe or magnifying glass if possible. If 
the nozzle check fails, please clear the printer before printing the profile targets. 

Adobe Photoshop Instructions 
If you open the image in Photoshop, ensure that it is 
not converted to a default working color space. If 
Photoshop gives a "Missing Profile" warning, select 
the "Leave as is (don't color manage)" option. If you 
get no such warning, please double check your 
Photoshop Color Settings (see below) to make sure 
the file is not being converted without your 
knowledge. 

 
 

 
 
 

Photoshop Color Settings 
If you are in doubt as to what Photoshop color settings to use, Adobe has an excellent, safe preset. In 
Photoshop CS2, it is called "North America Prepress 2". In previous versions of Photoshop, the settings are 
named "US Prepress Defaults." Don't worry if you are outside North America – the setup is a good one. 

1. Choose preset here. 

2. If you primarily use an RGB 
color space other than Adobe 
RGB (e.g. Pro Photo RGB or 
sRGB), choose it here. 

3. If you use only one RGB color 
space, leave the "Ask When 
Opening" profile mismatch 
warning checked. If you use 
multiple RGB spaces, and the 
warning proves annoying, disable 
it. The other two warnings are 
vital to prevent Photoshop from 
performing color space 
conversions without your 
knowledge. 
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Photoshop Print Dialog Settings: 

To print the file(s) from Photoshop, you need to ensure that no color management is being performed and 
that the image is printed without being resized in any way. In Photoshop 7 and newer, select File→Print 
With Preview. In Photoshop 6, the File→Print Options command brings up the same dialog box. You may 
need to click the "More Options" button (Photoshop CS2) or check the "Show More Options" box 
(previous versions) to see all the options. 

 
 
The critical parameters are the disabling of any color management and ensuring that the document is not 
scaled during printing. If you need to crop the width or otherwise rescale the target, please see Appendix A. 
Finally, make sure you have the correct paper orientation selected. All our profile targets are designed to 
print in Portrait orientation. 

1. Make sure the Scale to Fit Media box is not checked. If it is, we may not be able to measure your 
targets accurately. 

2. The Print parameters (CS2) or Source Space (Photoshop 6 through CS) must be set to "Untagged 
RGB". If you do not see this option, close the target image, re-open it, and ensure that you select 
"Don't color manage". 

3. In Photoshop CS2, the output options must be set to "No Color Management". In earlier versions, 
choose "Same As Source" for the print space. 

Other image editing applications have different terms for these options. The basic drill remains the same: 
Ensure the targets do not get a color space associated with them, turn off color management in the printer 
driver, and make sure the print is made without using profiles. 
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QImage Instructions 
QImage is a popular Windows program for printing and basic editing. Our profiles work equally well in 
Photoshop or QImage – you do not need separate profiles for each program. 

The key to printing profiling targets from QImage, however, is to disable the automatic image sizing 
QImage performs. Otherwise, the target sizes can be changed, making them difficult or impossible to read 
accurately. The settings below are not going to be the ones you use for normal printing. We need to turn off 
many of QImage's features to make sure the targets are sized correctly. Please use these settings. If the 
targets are misprinted there can be delays in processing or we may require new targets altogether. 

The QImage interface changes often. These instructions are for Version 2005.301. 

First, we need to prevent QImage from resizing the image. 
Ensure the image fitting button is down to force the "Crop to 
Size" option [1]. 

Check if a printer profile (anything in green type) is listed after the "Prtr ICC:" prompt. If so, left click on 
the profile name to toggle the setting to OFF [2]. Disable interpolation [3] and sharpening [4] as well. 
These must be done to preserve both the color information and page layout. Note: This only applies to 
printing the profile targets – for normal printing in QImage all sharpening and interpolation options are 
compatible with profile use. 

Select the "Center Placement" option (top menu bar button, under the "Queue" or "Prints" 
menu item):  

Turn off the Borderless Overspray/Expansion option. 
Otherwise, QImage can randomly resize images on 
certain printers. 

Finally, the page setup (Page→Edit Page) needs to be completed. Do not select a page size larger than your 
printer can print! Either choose an appropriate paper size 
from the defaults or enter the size you wish to use. Our 
targets are either 8x10 or 11x14 inches. The paper width (in 
portrait orientation) must be correct. Click the "Center" 
button. Ignore any warnings about exact centering being 
impossible – it does not matter for our purposes. 

 

 

Print using the appropriate settings for your printer, with all 
color management disabled in the printer driver. See the 
sections above for suggestions and examples. 
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Shipping and Handling Instructions 
Once you print the profiling targets, allow them to dry overnight in a dark location before mailing to us. 
This allows the ink to set and/or the paper to cure fully prior to the rigors of postal handling. 

For inkjet targets, first let the prints sit for 30 minutes. Next, place a sheet of plain paper on top of each 
target print and store the prints at least overnight. The plain paper absorbs residual solvents that outgas 
from the inks and speeds drying. The next day, remove the plain paper sheets and discard. Separate prints 
with fresh sheets of clean paper, archival tissue, or enclose them in protective sleeves. Package the print(s) 
in a rigid envelope or tube. 

Please, do not write on the back side of the target prints! The measurements will be adversely affected. 

We recommend enclosing prints in plastic sleeves to prevent them from absorbing moisture from the air 
during shipping. This is particularly important for our overseas customers where shipping times can be 
longer. 

After you receive your custom profile(s), print out a copy of the evaluation target on each paper stock you 
have a profile for. This time, print the target using your profile. Select the Relative Colorimetric rendering 
intent. Store the target in an archival sleeve in a dark place. When you change inks or ribbons, print out 
another evaluation target using the appropriate profile and Relative Colorimetric rendering. Let the target 
dry overnight, and compare the neutral steps along the top edge. If you see noticeable color differences, it is 
time for a new profile. For inkjet prints, it is important to wait before performing critical evaluations. Most 
inks and dyes require a curing period of at least several hours before the colors stabilize. 
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Installing Your Profiles 
 
Your ICC printer profiles will be delivered by email. These are relatively large files, over 1MB apiece. Our 
profiles contain a great deal of data about how your printers behave, hence the size. 
 
Before profiles can be used by applications such as Photoshop, they must be installed on your system. 
Windows and Mac OS/X users can simply drop the profiles in the appropriate folder. Users of Mac OS 9.x 
need to go through an additional step. 
 
Profile locations – Install the profiles in the following directories, depending on your operating system: 

• Windows XP: \Windows\system32\spool\drivers\color 

• Windows NT/2000: \Winnt\system32\spool\drivers\color  

o The simplest way for Windows 2000 and XP users to install a profile is to right click on the file 
and choose "Install Profile". 

o If you are installing an updated profile that has the same name as the original, however, 
Windows will not actually install the updated profile. You must manually copy the profile to the 
correct directory. 

• Windows 98/ME: \Windows\System\Color 

• Mac OS X: Storing profiles in /Library/ColorSync/Profiles allows all users to use them. An alternative 
area, for users without Admin privileges, is /Users/<username>/Library/ColorSync/Profiles — any 
profiles stored here are available only to the current user. 

• Mac OS 9.x: Systems Folder/ColorSync Profiles 

o To preserve the file formats across mailing systems, your profiles will be compressed in a Stuffit 
Archive. Many archive expanders read Stuffit files; you can download the free Stuffit reader from 
www.stuffit.com. Each file within the archive is encoded in BinHex format. Depending on your 
system setup, the profiles may be fully extracted, or you may need to the BinHex files through 
Stuffit again. 

o If the files extracted from the .sit archive have the extension ".icc", skip the next step. 

o If the extracted files have the extension ".hqx", drop the ".hqx" (BinHex) files on Stuffit again to 
fully extract the ".icc" (Icc Profile) files. This convoluted setup proved necessary to fully preserve 
the Mac resource fork information across mailing systems. 

o Install the profiles (".icc" files) on your system. You can either drop the profile on your System 
Folder and it will automatically be installed in the ColorSync folder, or you can open the System 
Folder and manually place the profiles in the ColorSync Profiles folder. 
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Example Workflow for Using Profiles 
Included below is a sample work flow for using ICC printer profiles taken from the tutorials on our web 
pages. It errs on the side of completeness, so do not be taken aback by the detailed steps. 

1. If you have not already installed the profile(s) on your system, you need to do so before proceeding. 
2. Open the image in Photoshop.  

o In Photoshop 7 and above, if you are presented with a profile mismatch dialog, select "Use the 
embedded profile". Do not let Photoshop convert the file upon opening. Without knowing what color 
space to convert from, this is asking for trouble.  

o In Photoshop 6, you have the option of assigning the correct profile when opening the file. 

3. If you have a profile for your scanner or digital camera, you may need to assign it to the image. Most 
RAW file converters and scanning programs handle the conversion for you, so you can skip this step. 
Likewise, if you do not use camera or scanner profiles, skip this step. 

o Some products (notably Nikon Capture and Nikon Scan) require manual intervention. Assigning the 
profile (Edit→Assign Profile in Photoshop CS2; Image→Mode→Assign Profile in previous 
versions) tells Photoshop how to interpret the image colors. 

o Convert the image to a suitable editing color space. If you don't have other preferences, Adobe RGB 
is a reasonable choice. You do not want to edit the image in the device color space -- it describes 
how your camera or scanner sees the world, which does not translate into a well behaved editing 
space.  

o The conversion process can be turned into an action or droplet for automatic/batch processing. 

4. Edit the image until you are happy and save the file. Do all your editing in a standard color space such 
as Adobe RGB or sRGB, not a printer profile. Editing color spaces are designed for editing. Printer 
color spaces are not. At this point you have an image that can be printed on any printer. 

5. Make a duplicate of the image. This allows you to keep the original as a printer-independent version, 
which can then be formatted for any other output medium. We'll now work on the duplicate, and tune it 
to optimize the colors you get on your printer. 
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6. Now it is time to soft proof to see how the print will look. Choose the duplicate image, and select 
View→Proof Setup→Custom, and load the appropriate printer profile. 

 

7. Select the profile to use from the drop-down list in the Proof Setup dialog box. 
8. Check the Preview box and turn on Black Point Compensation to accurately scale the black level in 

your image to the printer's black. 
9. Do not select Preserve RGB/Color Numbers. This shows how your image would look if you did not do 

a color space conversion — just the opposite of what you want. 
10. Experiment with rendering intent. You can quickly switch between rendering intents in the Soft Proof 

dialog - just have the Preview option checked. Relative Colorimetric often gives the best results. 
Perceptual or Saturation can be better if your image contains many out-of-gamut colors. Absolute 
Colorimetric rendering is often used for mid-stage print proofing; if you are familiar with this, you don't 
need this document. 
o For most images Relative Colorimetric rendering produces superior results. For others, Perceptual 

will be far better. These cases include images with significant shadow details where a slight 
lightening of the print is acceptable to open up the shadows. Also images with areas of highly 
saturated color can benefit from Perceptual rendering. If you see color banding is the soft proof with 
Rel. Color. selected, try Perceptual. With experience you will get a feel for which images best pair 
with each rendering intent. 

o Our profiles also feature a Saturation intent that is tuned to provide maximum useable saturation in 
the prints. If an image will benefit from increased saturation, give the Saturation intent a try. Most 
profiles either reserve the Saturation intent for PowerPoint-type graphics use or simply map it to the 
Perceptual intent. Our new profiles are designed to give photographers another technique to get the 
best prints possible. 

o Note: If you have setups that you use frequently, they can be saved using the "Save" button in the 
Proof Setup dialog. This makes the setting available directly from the View→Proof Setup menu. 

o If you wish to save a proof setup as the default, hold down the Alt/Option key. The "Save" button 
changes into "→Default". Push the button to save the selected proof setup as Photoshop's default. 
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11. Simulation Options: 
o These attempt to show the reduced contrast range the printed page will have vs. what your monitor 

can show. Without them you will have an over-optimistic view of the final contrast. 
o It is easiest to perform any major color and tonal adjustments without Simulate Paper Color 

(Photoshop CS2) or Paper White (Photoshop 6.0 through CS) or Ink Black checked. 
o The Simulate Black Ink (Photoshop CS2) or Ink Black (Photoshop 6 through CS) simulation should 

be checked to see if the shadow detail in your source image will hold up in print. This is particularly 
important for images with significant shadow detail. If your shadow details disappear, selective 
dodging can bring them back. 

o Simulate Paper Color/White attempts to show the effects of the difference between your monitor's 
white level and the (usually) less bright paper. This simulation is less accurate than the Ink Black, 
but can be helpful for ensuring critical highlight details hold up. 

o When you check the Simulate Paper Color box, the look of the image will likely change 
dramatically. This is an artifact of Photoshop trying to make the light emitted from your monitor 
match the look of light reflected from the printed page. The simulation works best if all white user 
interface elements (toolbars, palettes, etc.) are hidden. Use Photoshop's Full Screen mode for the 
most accurate view, and glance away as you switch the simulation on. 

12. If you do not see significant changes when soft proofing, this is OK. This means your image contains 
colors that mainly lie within the printer's gamut. If the images do not match well enough, the following 
steps can help. 

13. Set the highlight and shadow points in the Levels dialog box. In Photoshop, hold down Alt/Option 
while adjusting the level sliders. This will show any shadow or highlight clipping that occurs. The ideal 
setting is usually the point right before clipping occurs. 

14. If the duplicate image that you are Soft Proofing looks greatly different from the original, minor curves 
or color balance adjustments are often all that are needed to bring things into line. 
o What's going on? The problem is that your monitor screen is capable of showing a much wider 

contrast range (usually 300-500x between black and white) than is the printed page. By adjusting the 
Soft Proof image you can visually compensate for some of the discrepancy. An intelligent levels 
adjustment, or slight boost to saturation is usually all it takes to give your prints the needed pop. 

15. An optional step is to check the image for out-of-gamut colors (View→Gamut Warning). 

o If you do not like how the profile handles the out-of-gamut colors, first check the rendering intent 
alternatives. If none are acceptable, you can manually bring the colors within gamut. This will not be 
as mathematically accurate as the profile, but it can preserve the aesthetic feel of the image.  

o Open the Hue/Saturation tool. Use the eyedroppers and color selection sliders to select the out-of-
gamut colors. You can (in order of preference) change the lightness, tweak the hue, or very slightly 
reduce the saturation to bring the problem colors within gamut. Note that all your edits are being 
performed in the file's editing color space rather than in the printer color space. This makes edits 
more predictable and controllable. 
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16. Any remaining color casts or lack of saturation can usually be fixed by minor curves tweaks. See the 
references on our web site for links to books and web sites on editing techniques. 

o If you can't seem to get one or more colors right, the problem may be that your monitor is not 
capable of displaying the colors correctly. To check for this, soft proof using your monitor profile, 
and turn on the gamut warning (View→Gamut Warning). This is a useful technique in other cases, 
and is a good check when your prints do not match your monitor. 

17. At this point, you may want to convert the image to the output color profile (Image→Mode→Convert 
to profile). This is particularly true if you are sending the image to be printed on a device like a 
Frontier. Frontiers do not read embedded profiles, so without the conversion, all your hard work will be 
wasted. If you are soft proofing, the image will change appearance at this point. Photoshop is not bright 
enough to remember your Paper White and Ink Black simulation settings, so the image is shown 
without the benefit of these tools. 

18. Our preference is to archive both versions of the image — the original and the converted and profiled 
duplicate. To print the image on a different printer, start with the original rather than performing 
endless series of profile conversions that will slowly degrade the image. 

http://www.drycreekphoto.com/Learn/resources.htm
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Printing With Icc Profiles 

1. If you are printing directly from Photoshop, you want to ensure that your printer is set up exactly as it 
was when you printed the profiling target. In most cases, this means turning off all printer color 
management and automatic image enhancements. You are letting the profile and Photoshop's 
conversion do the color work rather than relying on some image-dependent algorithm. 

2. If you are using a CMYK printer, the details of CMYK separations are beyond the scope of this brief 
list. In most cases, this is not terribly difficult – get a good reference book. We have a list of helpful, 
well-written books in the resources section of our web site. 

3. In Photoshop 7 and later, use the Print With Preview dialog for printing. It gives you the necessary 
control over the color management functions. 

 

4. If the full dialog is not visible, click the "More Options" button (CS2) or the "Show More Options" box 
(earlier versions). 

5. Select "Color Management" from the drop-down list. 
6. Select "Document" in the Print section (CS2) or Source Space (6 – CS). 
7. If your document is in a standard editing color space, choose the appropriate printer profile and 

rendering intent in the output/Print space area. For Photoshop CS2 users, you need to select "Let 
Photoshop Determine Colors". 
o You almost always want to have "Black Point Compensation" checked. This scales the black level to 

match your printer's capabilities. 
o If the image is already converted to your printer profile, choose "No Color Management" in CS2's 

output options or "Same as Source" in earlier versions of Photoshop. 
8. If you are sending the image out to be printed, talk with the lab to make sure they do no further color 

adjustments or conversions to your work. 

http://www.drycreekphoto.com/Learn/resources.htm
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Print Matching 
If you have concerns about prints matching your display, first ensure that the monitor is accurately 
calibrated and profiled. As mentioned above, the entire color managed workflow hinges on your monitor's 
color accuracy. Without an accurate monitor profile, a printer profile has nothing to match to. 

Assuming your monitor is accurately calibrated and profiled, check that your monitor profile is actually 
being used by Photoshop: 

• Open the RGB Working Space list in Photoshop's Color Settings dialog box. 

• Scroll up until you come to the line "Monitor RGB – xxxx". 

• If xxxx is not the name of your monitor profile, something is amiss. 

• Either your profile is not installed as the system default, or the profile itself is bad. Try regenerating the 
profile. 

• Important: Press Cancel to exit the Color Settings dialog box without inadvertently doing something 
dumb such as selecting your monitor profile as your default working space. 

Our profiles are also tuned by default to viewing under D50 illumination. This is not the same as standard 
incandescent, fluorescent, or sun light. We can create profiles for these conditions, but D50 is the 
publishing industry standard. For critical color matching, view the prints in a D50 light booth, preferably 
with an adjustable dimmer. The light emitted from your monitor will never be a perfect match for light 
reflecting from a print surface, but our printer profiles combined with your accurately profiled monitor 
should get you very close indeed. 
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Appendix A – Target Cropping and Sizing 
 

Our profiling targets can be resized to a certain extent. This includes changing print resolution and 
increasing or decreasing the paper size. The target colors must not be affected by this process, and the size 
of the measurement field must remain fixed. Several scenarios are outlined below: 

 

Changing Target Print Resolution: Our regular targets are printed at 300 ppi. If your printer has good 
image interpolation algorithms (e.g. optical printers such as Durst Lambda, LightJet, Chromira, etc.), 
simply send the target to the printer. Otherwise, resolution scaling is most easily performed in Photoshop. 
Use the "Nearest Neighbor" interpolation in the Image Size dialog. This preserves the full color 
information – we do not want the color blending that other interpolation modes create. Make sure the 
"Constrain Proportions" option is checked to prevent target distortion. Only change the resolution, not the 
pixel dimensions, width, or height. 
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Reducing paper width: The width of the 8x10 targets can safely be reduced to 7.5 inches. Use Photoshop's 
Canvas Size to precisely crop the center of the image. Select the Center anchor, and do not change the 
height. Click "Proceed" when Photoshop prompts that clipping will occur. 

 
 

 

Increasing canvas size: If you need to make the paper size larger, simply use Photoshop's Canvas size. Do 
not use Image Size to increase the dimensions of the target patches themselves. 

 

Special Requests: If you are having difficulty fitting our targets into your printer environment, please 
contact us. In most cases we can generate a custom sized target to meet your needs. 
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Appendix B – Fuji Frontier Profiling 
 

Our Fuji Frontier targets are sized for 8x10 printing only. If you require other size targets, please contact 
us. We can support any standard paper size on an as-needed basis. 

The targets are designed to be printed using the "Fill In" cropping mode. Please do not print with additional 
borders or in a different cropping mode. The targets are slightly oversized to take the standard overprinting 
into account. Perform a calibration cycle prior to printing the profile targets. 

All the automated digital image processing corrections must be disabled. These include the Image 
Intelligence, FDIA, Hyper-tone processing, color gradation processing, contrast and exposure correction, 
etc. All these corrections perform image-specific adjustments that are incompatible with a profiled 
workflow. 

Checking for Image Intelligence 
Check the gray step wedges printed on each page of the targets. If step 1 (light gray) prints as white, Image 
Intelligence is probably on. Turn it off and reprint the targets. 

    
 Normal Print Image Intelligence Enabled
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Appendix C – Noritsu MLVA and Laser Profiling 
 

The MLVA (model 2xxx) Noritsu printers and the Laser (Model 3xxx) series have their own profiling 
targets. This is primarily to compensate for the difference in output resolution. The MLVA printer targets 
are 400 ppi tiffs, while the Laser model targets are 320 ppi. 

Our Noritsu targets are sized for 8x10 printing only. If you require other size targets, please contact us. 

o The targets are designed to be printed using the "CUT" cropping mode. Please do not print with 
additional borders or in a different cropping mode. The targets are slightly oversized to take the 
standard overprinting into account. 

o Function ►Menu ► Extension ►Setup ► Print Channel 

o Please use the "CUT" mode even on newer Noritsu 3xxx printers that have 300 ppi output 
resolution. 

o All automated digital image processing corrections must be disabled. On Noritsu QSS machines, 
these include: 

o Digital Media Corrections: Uncheck the "Media Correction (Usual Media)" box if printing 
from a CD. 

o DSA/Judgment Image Correction adjustments. Confirm DSA settings of Contrast 0, 
Sharpness 0, and Chroma 100. 

o The channel ± corrections should normally be set to zero as well. 

o We strongly recommend performing both the Daily Setup and Emulsion Number Change 
calibrations prior to printing the profile targets. 
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Kodak DLS 
For Kodak DLS controlled printers, we have not seen acceptable print quality with any DLS software 
versions before 3.0. We strongly recommend upgrading to Version 3.0 or newer before purchasing printer 
profiles. 

Several image enhancements need to be disabled on DLS printers to get correct color output: 

• In the System Configuration screen, select the Image Defaults tab. 

• Set the Tone Scale to Low. 

• Disable both Contrast Normalization and Underexposure. 

• Set Saturation to Normal. 

• These settings should be saved as a preset to recall when profiled prints are run. 
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Appendix D – Agfa d-Lab Profiling 
 

Our Agfa d-Lab targets are sized for 8x10 printing only. If you require other size targets, please contact us. 

All automated digital image processing (dTFS) corrections must be disabled. We recommend printing with 
the normal cropping mode instead of Reproduction mode. The color response is different in Reproduction 
mode, and this mode does not allow the printer to interpolate your customer's images to the desired print 
size. 
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Appendix E – Determining Inkjet Media Type 
 

If you use third party inks or papers for an inkjet printer, the printer driver will not have a built-in preset for 
your particular combination. The paper type chosen is critical to getting high quality prints. This governs 
ink limiting and linearization, dot placement algorithms, and related print parameters. Some inkjet paper 
manufacturers offer their recommendations of paper type to choose for particular printers. These are 
usually the best place to start. If you do not have a setting for your particular combination of printer, paper, 
and ink, our printer evaluation target can be used to find the optimum setting. 

Four copies of the printer evaluation target can fit on a single A4 sheet. Select a likely media setting/paper 
type and print one version in the upper left corner of the page. Use Photoshop's Print with Preview options 
to select the print location. It also helps to print in Landscape orientation. Wait a few minutes for the print 
to dry, choose a different media setting, and print again. This time, print the image in the upper right 
corner. Repeat for two additional media setting or paper type choices. 

 

Evaluating the test prints 
The Printer Optimization section earlier in this document contains a full description of the target and 
overall evaluation strategies.  The quick summary is: 

• The most important factor is the gray scale at the top of the target. Look for the option that gives the best 
shadow resolution. 

• Overall color casts are not a concern – the profile will fix these. 

• As a sanity check, make sure the finest ink density check crosshairs are not completely filled in. Also do 
not use any options that produce paper warping in black areas from over-inking. 

• It is better to choose a media setting that deposits slightly too much ink rather than too little. The profile 
will help linearize the ink output. Too little ink on the paper reduces the printer's color range. 

• If you need a tie-breaker, look at the color gradient spectrum. Choose the option that produces the 
smoothest overall transitions with the greatest range into shadows and highlights. 

⇒ Make a note of the settings you used. You need to use them for both printing the profile targets and when 
you use the printer profile for your real prints. 
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Troubleshooting and Contact Information 
 
If you have questions about printing the profile target or using your custom profiles, please contact us: 
 
Dry Creek Photo 
5521 SE Hacienda St 
Hillsboro, OR 97123 
 

 
 
 
Thank you for your business. We wish you the best in printing. 
 
Sincerely, 
Ethan Hansen 
Director 
Dry Creek Photo 
October 26, 2005 
 
 

All Trademarks and Service Marks are the property of their respective owners. 
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